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1 Introduction

1 Introduction

1.1 Structure of the tutorial

The present tutorial guides you through your first steps with the
software tiamo™ . You will be introduced to the most impor-
tant operating features by using a simple pH titration as an
example.

The tutorial is structured in two parts:

Part 1: Titration without automation

= Configuration
— Connecting a Titrando or a Titrino
— Adding a titrant
— Connecting a pH electrode
=  Method
— Creating a method using a template
— Carrying out a titration
= Database
— Results view in the determination database
— Reprocessing a determination
— Printing a report

Part 2: Titration with automation

= Adding a USB Sample Processor to an existing titration sys-
tem and configuring it

= Modifying the titration method used in Part 1 in a few steps

= Creating a sample table in order to carry out a sample series



1.2 Program structure

1.2 Program structure

tiamo™ comprises the following program parts:

Workplace
= Open/Close workplaces
@‘ = Start single determinations and determination series

‘- = Create sample tables

Database

= Open/Close databases

= Manage databases

= Reprocess determinations

= Create method templates
Method

= Create new methods

= Open/Close existing methods

= Manage methods

Configuration
— = Configure devices, solutions, sensors, common varia-
bles and rack data
= Security settings
= User administration
= Audit Trail

= Dosing

= Preparing exchange/dosing unit
= Measuring

= Stirring

= Automation functions
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Detailed information on tiamo™ can be found in the online
help. [F1] opens the help for the corresponding dialog.

1.3 Symbols and conventions

The following symbols and styles are used in this documentation:

Instruction step

Carry out these steps in the sequence shown.

Method

Dialog text, parameter in the software

File » New

Menu or menu item

[Next]

Button or key

Note

This symbol marks additional information and
tips.
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2 Titration without automation

The following instruments are required for the titration descri-
bed:

= Titrando or Titrino
= Exchange unit or Dosino with dosing unit
= Stirrer

2.1 Configuration

2.1.1 Connecting a Titrando including a stirrer

Proceed as follows to connect a Titrando:

1 Connect the devices

= Connect a stirrer and — if available — an external dosing
device to an MSB connector of the Titrando.
= Connect the controller connector of the Titrando with a
USB connector on the computer.
— Use 6.2151.000 cable.
= Connect the Titrando to the mains supply.

2 Software settings

= Start tiamo.
The Titrando is recognized automatically:

009-108 Save device x|
"}l The new device ‘336 Titrando' with serial nurmber '02130° has
- been detected,

Should it be saved in the device table?

es ] | Mo
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= Confirm the message with [Yes].
The properties dialog of the Titrando is opened:

zl
| General | GLP ‘

Device namme |836_1 |

Device type |836 Titrando |

Program version |5.836.0022

Device serial number (02180

Set to work |2008-12-22 15:57:38 UTC+1

Remarks

[ Ok ] | Cancel ]

= Under Device name, enter a designation that
describes the Titrando unambiguously and confirm with
[OK].

The Titrando is added to the list of devices.
2.1.2 Connecting a Titrino

H NOTE

Titrinos are not recognized automatically and must be added
manually to the list of devices.

To connect a Titrino a RS-232 cable is needed:

= 6.2125.110 (25-pin — 9-pin) for Titrinos with 25-pin RS-232
interface

= 6.2134.040 (9-pin — 9-pin) for Titrinos with 9-pin RS-232
interface



2.1 Configuration

Proceed as follows to connect a Titrino:

1 Connect the devices

Connect the Titrino to the RS-232 interface COM1,
COM2, ... of the computer.

Connect the Titrino to the mains supply.

Switch on the Titrino.

2 Start the software

Start tiamo.

In the sidebar, click on the symbol [Configuration].

[®tiamo 2.0 - Configuration o |m]
File View Tools Help
FE Be8 0
1 Titrants,Solutions 0
@ Device type pevice serialn... |status Solutionname A | Concentration | Cylinder volume Type Dosi
%- 836 Titranda 0z1s0 ok 2008|
‘Workplace
Database
[] ] D Edt ¥ [ I D
_ Common Variables w
Sersor name A | Sensar type Set to wark. Expiry date Name A Type value Unit assigr
Configuration || p 1 |Conductivity sensor Conductivity sensor 2008-12-22
2 1S electrodz ISE electrods 2008-12-22 -59.3
3|Metslelectrode | Metalelectrods  |2008-12-22
4 |pH electrode pH electrode 2008-12-22 100,
S |Temperature sen... Temperature sen... | 2008-12-22

2

Manual

Edit ¥

Edt ~ [«]

Press F1 for help

]
I o [ 11

The program part Configuration has the following subwindows:




Devices
Titrants/Solutions

Sensors
Common Variables

Sample solutions
(TC conductivity)

Edit ¥

New...

Delete
Properties. ..
Column display...
Print (PDF}...
Initialize

Ignored devices...

2 Titration without automation

List of automatically recognized and manually
added devices.

List of automatically recognized and manually
added titrants and auxiliary solutions.

List of all sensors defined.

List of all common variables defined.

List of the solutions a temperature coefficient has
been determined for.

3 Add the device

In the subwindow Devices, click on the menu item

Edit » New....

Double-click the item Titrinos.
The list of the Titrinos available is displayed:

x|

o~ () Titrinos

] 719 5 Tittino

> ) Coulometers

o () Sample Changers
o IJJ Meters

> ) Balances

o () Miscellaneous

(— ] 702 SM Titrino
— ] 716 DMS Titrino
— ] 718 STAT Titrino

— ] 720 KFS Titrino
— ] 721 Net Titrino
(] 736 GP Titrino
— ] 791 GPD Titrino
— ] 758 KFD Titrino
(— ] 784 KFP Titrino
— ] 785 DMP Titrino
— ] 794 Basic Titrino
(] 795 KFT Titrino
-0
— ] 799 GPT Titrino

[

/1

Cancel

J

Select the Titrino from the list and confirm with [OK].

The properties dialog of the Titrino is opened:



2.1 Configuration

Properties - 798 MPT Titrino - 798_1 |

| General || nt. Dosingdevieebn | Rszaz | ale

Device name ‘793_1 ‘

Device type | 798 MPT Tiring |

Sek towork | Z008-12-22 16:11:40 UTC+H1

Remarks

Ok ] { Cancel

4 Configure the device
= Under Device name, enter a designation that
describes the Titrino unambiguously.
= Click on the tab RS 232.
x

General | It DosingdeviceDD | RS 232 | alp
COM Port | Cam1 (-]

Baud rate [COME

Cannect

l OK ] { Cancel ]

= Select the RS-232 interface of the computer the Titrino
is connected to.
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= Confirm the entries with [OK].

The Titrino is added to the the list of devices.

2.1.3 Adding and configuring a titrant

Titrant in an exchange or dosing unit with data
chip

H NOTE

The following description only applies if a Titrando is used.
For Titrinos: see page 11.

Proceed as follows to add a titrant to the list of titrants:

1 Attach the exchange or dosing unit

= Attach the exchange unit to the Titrando or the Dosino
to the dosing unit.
As soon as the exchange or dosing unit has been rec-
ognized the following message is displayed:

010-12Z Prepare dosing device 1[

p An exchange or dosing unit was put on dosing device 1 of
=4 device '836_1"

Flease open the Manual control and execute a prepare

command,
O

All tubings and cylinders are rinsed with the Prepare
function. Preparing exchange or dosing units is descri-
bed in chapter 2.3.1, page 27. The exchange or dos-
ing unit must first be configured.
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= Confirm the message with [OK].

The following message is displayed:

010-116 New exchange or dosing unit 1[

’) A mew exchange or dosing unit has been detected.

=
“fou must configure the new exchange or dosing unit under
"Zonfiguration - TitrantsfSolutions" before you use it

= Confirm the message with [OK].

The properties dialog of the titrant is opened:
|

Solution | Titer | Titer history | Exchange unit GLP
Solution name: | =]
Concentration | 1000 | [maliL =]
Cormment: | |

Production date l:l D
[ Solution monitoring

‘Working life days

ST B [ )

Message
O Message by e-mail E-mail... |
[ Acoustic signal
Action
O Record message
© Display message

(O stop determination

Ok ] I Cancel

Configure the titrant

= Enter a solution name or select an existing name from
the list.

= Define the concentration of the titrant.

= Switch on the option Solution monitoring.

= Asworking life enter, for example, 60 days.



Column display. ..
Brint (POF)...

r|_ Exchange Un... .
Dosing L. ..

2 Titration without automation

= Confirm the entries with [OK].

The titrant is added to the list of titrants.

Titrant in an exchange or dosing unit without data
chip

A titrant in an exchange or dosing unit without data chip must
be added manually to the list of titrants. The exchange or dosing
unit does not need to be attached for this.

H NOTE

If you use an exchange unit with data chip with a Titrino you
will also have to manually add the titrant to the list of titrants.

Proceed as follows to add a titrant to the list of titrants:

1 Open the program part "Configuration”

= In the sidebar, click on the symbol [Configuration].

2 Add a titrant

= In the subwindow Titrants/Solutions, click on the
menu item Edit » New > Exchange or Dosing
Unit....

The properties dialog of the titrant is opened:

11



2.1 Configuration

Titrant,/Solution - x|

Solution | Tier | Tierhistory | Exchangeunt | GLP
Solution name | =]
Concentration | 1.000 | [melit =]
Comment | |

Production date I:l [:]

[ solution monitoring

Wwarking life days
S

Message
[ message by e-mail E-mail...
O acoustic signal

Action

(O Record message

(@ Display message

(O stop determination

Ok ] [ Cancel

3 Configure the titrant

= Enter a solution name or select an existing name from
the list.

= Define the concentration of the titrant.

= Switch on the option Solution monitoring.

= Asworking life enter, for example, 60 days.

12
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= Click on the tab Exchange unit or Dosing unit.
x|

Salution ] Titer ]T\terhlstow ‘ Exchange unit GLP |

Hardware

Mame |
Order number l:l
Serial number l:l
Zylinder volume mL
Zylinder serial number l:l

Parametets for preparation

Dosing rate mLmin
Filling rate mLjmin

Tubing parameters

Length Diameter
Dosing tip | 4D‘D| om | 2.0 ‘ mm
Cylinder | 13‘D| o | 2.0 ‘ mm
Reagent bottle | 25‘El| om | 2.0 ‘ mm
[ Ok l ‘ Cancel ]

= Select the cylinder volume.

= Enter the number printed on the cylinder under Cylin-
der serial number.

= Confirm the entries with [OK].

The titrant is added to the list of titrants.

214 Configuring a pH electrode

Proceed as follows:

Edit ¥
Tiow S et 1 Add a pH electrode
Delete Metal electrode... . : i
Fraperies... I5E slctrode... = In the subwindow Sensors, click on the menu item
Column display. .. Temperature sensor... .
| et Edit » New > pH electrode....
- Cther sensor...

The properties dialog of the sensor is opened:

13
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sensor - E

Sensor [ Calibration data ] Linits I History ]

Sensar name | |

Sensor bype |pH electrode

|
Order number | |
|

Sensor serial number |

Device | El

Camment |

settowork (20081222 | [...]

[] sensor monitoring
‘Working life days

Expiry date [2011-08-17 ][]

g
O Message by e-mail E-mail... |

[ Acoustic signal

Action

) Record message
) Display message

(O stop determination

OK ] [ Cancel

2 Configure the pH electrode

= On the Sensor tab, enter a sensor name and the order
number.
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= (Click on the tab Calibration data.

sensor - =
Sensar Calibration data [L|rmts ] Histary I
Slope: o
PH (03
alibration temperature | 25.0 ‘ °C |manua|

Calibration date: |2DDS—12—22 16237106 UTCHL

User |]h

|
|
Calibration method | manual |
|
|

Measuring inpuk |

[ calibration data monitoring
Calibration interval | 7 | days
Next calibration [zoos-1228 ][]

Message
[ Message by e-mai E-mail... |
[ Acoustic signal
Action
O Record message
© Display message

O stop determination

[ Ok ] I Cancel ]

= Switch on the option Calibration data monitoring.
= Enter a calibration interval of, for example, 7 days.
= Confirm the entries with [OK].

The pH electrode is added to the list of sensors.

2.2 Creating a titration method

Below you will find a description of how to use a template for
DET pH titrations to create your own method.

15
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2.2 Creating a titration method

Loading the method template

Proceed as follows to load the method template:

1 Open the program part "Method"
= In the sidebar, click on the symbol [Method].

The method editor is displayed.

u Titration
E.J Chamnic titration pH

e o = Click on the symbol £} or the menu item

fd Blank methed 2 Select the method template

File » New....

= Double-click the item Titration.

= Select the method template Dynamic titration pH
and confirm with [OK].

The method is loaded:



START

Main track

I

DET pH

I

Calculations

I

Report

|

tiamo

Main track

DET pH

2 Titration without automation

The method template consists of the following com-
mands:

DET pH: Titration command

CALC: Calculation command

REPORT: Command for printing a determination
report

DATABASE: Command for saving the determination
in the database

The method is now already complete except for a few parame-
ters which you are just going to set.

Editing the titration command DET pH

Proceed as follows:

1 Open the properties dialog
= Double-click the command DET pH.

The properties dialog of the command is opened:

17
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2.2 Creating a titration method

Dosing device

Dosing device
Solution

Sensor
Measuring input
Sensar
Termperature measurement

Stirrer
Stirrer
Skirring rake

[ switch off automatically

not defined

pH electrode

aukomatic

g K g

Potentiometric evaluation 1 Additional evaluations 1 Additional measured values 1
General /Hardware [ Start conditions l Titration parameters Stop conditions
Device

Device name | not defined

Device type | Titrando

o

l { Cancel

General/Hardware

= Under Device name, select the connected Titrando or

Titrino.

= Under Dosing device, select the MSB connector the

dosing device is connected to. Select option 1 if you

have attached an exchange unit to the Titrando /

Titrino.

= Under Solution, select the newly configured titrant.
= Under Sensor, select the previously configured pH

electrode.

= Under Stirrer, select the MSB connector the stirrer is

connected to.
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3 Stop conditions

= (Click on the tab Stop conditions.
I

Command name |DET pH |

evaluation ] Additional evaluations I Additional measured values
are | Start conditions | Titration parameters | Stop conditions

Stop volume mL
Stop measured value pH off E
Stop EP
Walurne after EP ml
Stop kime off E 5

Filling rate mLfrnin

= Select the option Stop EP = 1.
= Under Volume after EP, enter the value 1.
= Confirm the entries with [OK].

=
o
=)
=]
=

Editing the calculation command CALC

Proceed as follows:

[ cac | 1 Create a new calculation

= Double-click the command CALC.

= Click on [Newl].

The dialog window New result is opened:



2.2 Creating a titration method

[¥caLc - Calculations x|
Command name | Calculations

Result name| Farmula | Unit |Dec|ma\ places‘ Assignment ‘ Statlstlcisesult

E® New result x|
Templates Description

Empty Empty default template |

[ MNext = ] [ Cancel ]

S— |

In this window predefined result templates can be loaded
and modified for new calculations. Because you have not
defined a template yet, the selection is empty.



2 Define result properties

= (Click on [Next >>].

2 Titration without automation

The properties dialog for the new result is opened:

x
” Definition ” Monitaring I Options ]
&=
Farmula
it
Decimal places
Assgnment
¥ statistics
Description
Save as kemplate [ [o]4 ] l Cancel

= As Unit, select the option %.

3 Open the formula editor

= Click on the symbol B or double-click the field For-

mula.

The formula editor is opened:

21



22

2.2 Creating a titration method

E= rormula editor x|

HEE B EEEEER (Aeler] MM & bl

Variables

OperatorsfFunctions

) UJ Method wariables ﬂj Operators

@ Uj Cammand variables U Functions

@ UJ Determination variables HJ Miscellaneous
C) UJ System variables

Description

[ Ok l { Cancel ]

The calculation formula is entered in the upper window.
Beneath, the most important mathematical functions are
listed as symbols.

In the subwindow Variables all variables available for this
method are listed in a tree-form structure. In the sub-
window Operators/Functions further mathematical func-
tions can be selected. Additionally, a short description is
shown for each variable or function.

The following steps describe how you can enter the simple
formula shown below for determining the content of a
sample:

Formula:

'DET pH.EP{1}.VOL' x 'DET pH.CONC' x 'DET pH.TITER' x

40.00 x 0.1/ 'MV.Sample size'

DET pH.EP{1}.vOL Volume of the first endpoint

DET pH.CONC Concentration of the titrant
used




IJJ Method variables
LJ Command variables
DET pH

| TTER

|0 conc

© eppg
Q

| mea

2 Titration without automation

DET pH.TITER Titer of the titrant used

40.00 Equivalent mass of the sample,
NaOH as an example here

0.1 Factor for conversion to %

MV.Sample size Sample size in g

Enter the calculation formula

Under the item Command variables, DET pH, EP{x},
select the variable VOL for the endpoint volume.

Click on [Add].

The variable is added to the formula.

Replace the x in the variable by 1, i.e. this variable con-
tains the volume of the 1st endpoint.

Insert the multiplication sign via the corresponding
symbol or with the keyboard.

In the same way insert the variables CONC and TITER.
Enter the equivalent mass of the sample as well as the
conversion factor.

Under the item Method variables, select the variable
Sample size and click on [Add].

The variable is added to the formula.

Confirm the entries with [OK].

The formula editor is closed and the properties window of
the result is displayed.

Apply the calculation

Click on [OK].
The calculation is entered in the result table.
Click on [OK].

The table dialog is closed.

23
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2.2 Creating a titration method

Editing the report command REPORT

Proceed as follows:

| reporT | 1 Open the properties dialog

= Double-click the command REPORT.

The properties dialog of the command is opened:

H
Report template
Report template

Report output

W1 printer

O POFfile I

O send e-mal IWI

[ O l ‘ Cancel

2 Carry out settings

= Switch off the option Printer.
= Switch on the option PDF file

= (Click on |:]

The dialog window Save is opened.

= Select the memory location, enter the file name and
confirm with [Save].

= Confirm the entries with [OK].

The properties dialog is closed.
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Editing the database command DATABASE

Proceed as follows:

1 Open the properties dialog
= Double-click the command DATABASE.

The properties dialog of the command is opened:

= DATABASE - tiamo x|
Database

Mew l ‘ Propertizs | | Delete ‘

l OK ] ‘ Cancel ]

2 Select database
= (Click on [Newl].
= Select the standard database tiamo and confirm with
[OK].
= (lick on [OK].

The properties dialog is closed.

The method is now ready and can be checked with a method
check and be saved afterwards.

25
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2.2 Creating a titration method

Method check

Proceed as follows:

1 Start the method check

= Click on the symbol % or the menu item
File » Method check.

If the method check has been completed successfully, the
following message is displayed:

013-118 Method test ok x|
o The method test has been successfully finished.
[o]9

2 Finish the method check
= Confirm the message with [OK].

Saving the method

Proceed as follows:

1 Open the method table

= Click on the symbol & or the menu item File » Save
as....

The following dialog window is opened:
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x
Methad group |Mam group lz“
| Name A ‘ Saved ‘ User | Full name |Versiun | Signed |

[ | D

Method name ‘Tutor\al ‘

[ Save ] | Cancel ]

2 Enter a method name

= As method name, enter Tutorial and confirm with
[Savel].

The method is saved.

2.3 Carrying out a titration

2.3.1 Preparing the exchange or dosing unit

The Prepare function is used to rinse and fill air bubble-free the
cylinder and tubings of the exchange or dosing unit. You should
carry out this function before the first determination or once per
day.

Proceed as follows:

1 Open the manual control

= In the sidebar, click on the symbol [Manual].

27
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2.3 Carrying out a titration

Titration devices
©-836_1 (836 Titrando)
Measuring inputs
Measuring input 1
Measuring input 2
Dosing devices
-
Stirrers
L stirrer 1 (804)
Sample changers
Measuring devices

E®Manual control (=] ]
General | prepare | Fil | Empty | Addfixedvolme | Dosing |
Exchange,/Dosing unit
Hame |
Tope
Cylinder volume m
Solution
Solution [Hc
Ther 100
| —
2 4
Il
Close

In the left-hand part of the window the control devices
connected are listed together with their peripheral devices.
In the right-hand part of the window the functions of the
device selected are displayed, in this example those of the
dosing device.

2 Select the dosing device
= In the left-hand window, select the dosing device
whose exchange or dosing unit is to be prepared.
= Click on the tab Prepare.
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3 Start the preparing

n NOTE

Make sure that the buret tip is directed into a vessel that
can accommodate the volume of your exchange or dos-
ing unit several times over.

= C(lick on [Start].
The following message is displayed:

010-132 Splash warning x|

"’r’j Check the buret tips, They should point into & vessel,
=

Do ywiou wank ko continue?

[ Yes ] ‘ Mo

= Confirm the message with [Yes].

Preparing is carried out with the default parameters. The
parameters can be found in the online help. They are differ-
ent for exchange and dosing units.

4 Close the manual control

= Close the manual control after the preparing has been
completed. Click on [Close].

2.3.2 Carrying out a titration

The titration is carried out in the program part Workplace.

29
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2.3 Carrying out a titration

E®tiamo 2.0 - Workplace

Il
Fle Yen ook Hep
DB BFE v LWS@E 8 0
1
74 ‘ [ Single determination | Determination series |
‘_ I
|20l | M Stop || IHold Statws |
‘Workplace
Determinati
user [ Sample umber | 0
W — =l
Sample data
Database: Method [ =]
Method

c Latest report | Selected repart Report overview

Manual

Press F1 for help

| [ 1

The program part Workplace has the following subwindows:

Method
Run

Report

Live display

<8

Display of the method currently loaded.

Window for controlling run sequences and entering sam-

ple data.

Display of the reports of the determinations carried out
since having started the program.

Display of live curves, measured values and messages for
the determination running.

Proceed as follows to carry out a titration:

1 Open the program part "Workplace"

In the sidebar, click on the symbol [Workplace].
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Load the method

= |n the subwindow Run under Method, select the pre-
viously created method Tutorial.

Single determination | Determination series

Determination parameters

User |]b Sample nurber ljl
Remark | E”
Sample data
Method | [-]
|Tutorla\ Iy |
b

Prepare the sample

= Weigh in the sample in a sample vessel.

= Add solvent.

= Place the sample vessel on the stirrer.

= Immerse electrode and buret tip in solution.

Enter the sample size

= Enter the sample size (Sample size), e.g. 5.0.
= Select Sample size unit =g.

Start the titration
= (lick on [Start].

The titration is started.

The currently active command is highlighted with a red
frame in the subwindow Method.

31
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2.3 Carrying out a titration

Configuring the live display

While the titration is running, configure the live display the way
you can directly follow both the titration curve and the current
measured values.

Proceed as follows:

1 Open the properties dialog

= Right-click the subwindow Live display.
The context menu is displayed.
= Click on the menu item Properties Live display.

The properties dialog of the live display is opened:

Properties - Live display 1
conmendiype [ET____ 7]

x

[ Measured value display
Measured value 1
Measured value 2

Measured value 3

¥l curve display

[ show measuring poinks

[ show grid

Al

Background |

{ [+]4 | iZancel J | Apply

2 Carry out settings

= Switch on the option Measured value display.
= Confirm the entry with [OK].

The live display now looks like this:



2.4

2.4.1

Database

Overview

2 Titration without automation

55

pH 5.451
v 2.4855 mL
T mavusi 25.0 °C

Y]

With the symbol I in the upper right-hand corner of the
live display you can enlarge or reduce the subwindow.

As soon as the determination is finished, a preview of the
report is displayed in the subwindow Report. Printing out
the report is described in the following chapter.

Open the program part "Database"

= In the sidebar, click on the symbol [Database].

Open the database

= Click on the symbol @ or the menu item
File » Open....

= Select the standard database tiamo and confirm with
[Open].
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[&tiamo 2.0 - tiamo =10l

File Edt Yew Determinstions Tools Help

0O A e ¢ BFER LSEH o Q%eTRHLODE E20l E2S @ 0

Determination overview w
o a Fiter [l [7]] statistics [an =]
E‘ | oetermination start ¥ [ method name I D1 Yalue I RS0 Name I RS0L.Value [ RSOL.UNE
wiotkplace || P 1[2008-12-23 13:30:09 UTCHL Tukorial Res0l 0.20 %
Database
Method
& [ NDeDeT i-1ofi IR ] »
B | covesg ——— ——— | (Resules ——————— —m|
DET pH.1 o comment: Results overview
Canfiguration G | Messages
DET pH

Determination Vethod | _sampls Command ‘Calculations’

2 ResDl: 0.20%
Identification el
10 Determination ID: -SaaaBcas:1les:
Server name:  127.0.0.1
8 B Client name; b2
T Sample number:
6 Start counter: B
Recording
4 Determination stark; 2008-12-23 13:3
— Determination duration: 955
&)

[T

Determination run:  regular wikh rem:

User (shart name)

N ;b
] |1 P — | E‘E‘
Manual

Press F1 for help @

The program part Database has the following subwindows:

Determination over-  List of the individual determinations, sorted according to
view date and time.

Curves Display of the titration curve.

Information General information on the determination such as deter-
mination start, method information, sample data, system
configuration etc.

Results Display of the calculated results and the variables used
for.

2.4.2 Adapting the layout

A short description is given about how to adapt the database
view to your own requirements.
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Configuring the curve window

Proceed as follows:

1 Open the properties window

= Right-click the subwindow Curves.
The context menu is displayed.
= Click on the menu item Properties Curves.

The properties dialog of the curve is displayed.

2 Display grid
= Click on the tab Options.

Command type |[DET

W] Autoscaling

| xaxis | yraws [ yzeds | Options | mMessuringpointlist |

] 5how grid Background
Grid type |———\z” Background color
Grid color | ] |z”

= Switch on the option Show grid.
= Confirm the entries with [OK].

The titration curve is shown with a grid.
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Configuring the determination overview

In the subwindow Determination overview you can define

which columns are to be shown. You can also freely select the
order of the columns.

For example, the columns User (short name) and Remarks

are to be deleted and then the column Method name is to be
moved.

Proceed as follows:

1 Define the column display

Click on the menu item View > Properties » Column

display.

The following dialog window is opened:

E#= colurn display

Columns avaiable

{ j Determination overview
2 IJJ Determination

& ) Methad

@ U Sample

@ IJJ Results

Columns displayed

Default name
1 |Determination start
2 |Method name
3 101 Malue
4 |R501 . Marme
5 |R501 . Yalue
& |RSO0L. Unit
7 |Sample size, Value
8 |Unit, Yalue
9 |User (short name)
10 [Remarks

Displayed name
Determination start
Method name
101 Value
R501.Mame
R301.¥alue
R&01.Unit
Sample size.Yalue
Unit. Yalue
User {short name)
Remarks

OF

l ‘ Cancel

2 Delete columns

Under Columns displayed, select the column User

(short name).

Click on the button [<<].
The column is removed from the list.

Proceed in the same way for the column Remarks.

Confirm the changes with [OK].
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The two columns are no longer shown.

3 Move columns

= |n the subwindow Determination overview, click on
the column title Method name and move this column
to the right by holding the mouse button pressed
down.

= Insert the column after the column RSO1.Unit (Drag &
Drop).

Reprocessing a determination

A simple example (modify the sample size) illustrates how to
recalculate a determination. Proceed as follows:

1 Open the dialog window

= Click on the symbol B o the menu item Determina-
tions » Reprocess....

The following dialog window is opened:

E®reprocessing x|
Modifications Result view
| variables | methad 1 Statistics ] Curve evaluation ] Results overview [ Rawv data 1
Variahle A | Value | Command "Calculations’
. 3
# 1 |DET pH.1.COMC 0.1 ResOli 0.20%
2 |DET pH.1.TITER 0,9935
3 |My.ID1
4 |My.1ID2
S [MY.ID3
& |MY.Sample position 1
7 My, Sample size 5.0
& |MV.Sample size unit ]
14 [
Wadify —— —
| [1)«]  1oFr [w]im]
| Recalculate | ‘ Undao | ‘ OK | | Cancel
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2 Modify the sample size
= Under Modifications, select the item MV.Sample
size.
= Click on [Modify].
x|

Wariable |MV‘SampIe size ‘

Yalue | 5.0 ‘

{ OK ] | Cancel J

= As new sample size, enter the value 5.3 and confirm
with [OK].

3 Start the reprocessing
= (lick on [Recalculate].

The progress is shown by a progress bar.

Under Result view, the new result is now displayed.

4  Finish the reprocessing
= Click on [OK].

The recalculated determination is saved as a new version.

2.4.4 Printing out a report

The PDF report automatically generated by the determination
can be printed out directly from the Database program part.
Proceed as follows:

1 Open the properties dialog

= Click on the menu item File » Print » Report.....

The properties dialog of the report output is opened:
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E
Selection
®[selected determinations]
O il Filvered determinations
Report type
® Original report(s)

O Report template | example report B|
Output target
W Printer | Default printer lz“
L] POF file [ | (-]
Ok ] l Cancel ]

2 Select a report

= Select the option Original report(s).

3 Print the report
= Select the required printer and click on [OK].

The report is printed.

n NOTE

If the determination has been recalculated as in this
example, the report of the recalculated determination is
printed out.
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3 Titration with automation

For the second part of this tutorial you require a USB Sample
Processor, a rod stirrer and a balance in addition to the titrator.

3.1 Configuration

3.11 Connecting a USB Sample Processor

Proceed as follows to connect a USB Sample Processor:

1 Connect the devices

= Connect a stirrer to the stirrer connector of the tower.
= Attach a sample rack.
= Connect the controller connector of the USB Sample
Processor with a USB connector on the computer or on
the Titrando.
— Use 6.2151.000 cable.
= Connect the USB Sample Processor to the mains supply.

2 Software settings
= Start tiamo.
The USB Sample Processor is recognized automatically:

009-108 Save device x|

"}l The new device ‘815 Robatic USE Sample Processor kL' with
- serial number '00002" has been detected,

Should it be saved in the device table?

es ] | Mo
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= Confirm the message with [Yes].
The properties dialog of the USB Sample Processor is

opened:

Propetties - 15 Robotic USB Sample Processor XL -8 x|
| General | GLP ‘

Device namme |815_1

Device type |815 Robotic USE Sample Processor KL |

Program version |5.815.0024
Device serial number (00002
Set to work [2008-12-23 13:59:13 UTC+1

Remarks

[ Ok ] | Cancel ]

= Under Device name, enter a designation that
describes the USB Sample Processor unambiguously

and confirm with [OK].

The USB Sample Processor is added to the list of devices.

3.1.2 Connecting a balance

H NOTE

Balances are not recognized automatically and must be added
manually to the list of devices.

Proceed as follows to connect a balance:

1 Connect the devices
Connect the balance to the RS-232 interface COMT1,
COM2, ... of the computer.

41
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= Connect the balance to the mains supply.
= Switch on the balance.

2 Start the software

= Start tiamo.
= In the sidebar, click on the symbol [Configuration].

Edit ¥

New. ..

3 Add the device

o = In the subwindow Devices, click on the menu item
Column display... Edit » New....

Frint (PDF)...

Intilze = Double-click the item Balances.
LS The list of the balances available is displayed:
=

o L Titrinos
=~ L) Coulometers
o ) Samnple Changers
o ) Meters
5 ) Balarces
] AND
| Mettler
| Mettler AT
] Mettler &%
|1 Ohaus
| Precisa
]
|1 Shirmadzu
=~ L) Miscellaneous

Delete

l OK ] { Cancel ]

= Select the balance from the list and confirm with [OK].

The properties dialog of the balance is opened.



Properties - Sartorius - Sartorius_1

General | RS 232 GLP

3 Titration with automation

Device namme |Sartnrius_1

Device type |Sart0rius

Frogram version

Device serial number

|

Set to work [2008-12-23 14:27:09 UTC+1

[ pata storage under legal control

Remarks

Ok ]

l Cancel

4 Configure the device

Under Device name, enter a designation that
describes the balance unambiguously.

Under Device serial number, e
of the balance.
Click on the tab RS 232.

Properties - Sartorius - Sartorius_1

General R§232 | GLP

nter the serial number

K

COMPott ([COML
Baud rate
Data bit
Parity | Mone
Stop bit
Handshake | Mone

Timeout

Terminator For send | {00404

mjx

Terminator For receive 400404

!

Code page | Cp437

Conneck

o

K

Cancel ]

J(
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3.1 Configuration

Select the RS-232 interface of the computer the bal-
ance is connected to.

Set the connection parameters. These settings must
match the settings on the balance (see manual of the
balance).

5 Test the connection

Click on [Connect].
The following dialog window is opened:
x

Please press the Print button on the connected balance
to best the connection. The data will be entered inta the
appropriate fields iF the connection is ok,

Device name ‘ ‘

Sample size :’ Sample size unit :’

01 | |

1z | |

{ Ok ] | Cancel J

Press the [Print] key on the balance in order to check
the connection.

If the correct connection parameters have been
entered, the corresponding data is inserted in the fields
Device name, Sample size and Sample size unit
will be filled in with the corresponding data.

Click on [OK].

Confirm the entries with [OK].

The balance is added to the list of devices.
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3.1.3  Assigning lift positions

In this chapter you will learn how to define lift positions. This is
necessary in order to carry out the subsequent titration with the
Sample Processor.

Proceed as follows:

1 Equip the titration head

= Equip the titration head with all necessary accessories
such as electrode, dosing tip etc. (see manual of the
Sample Processor used).

= Place a sample vessel at position 1 of the rack.

2 Open the manual control
= In the sidebar, click on the symbol [Manual].
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3.1 Configuration

-oix
2 Titration devices
& b3 1 (o8 Tirando) General | Move | Assignpostion | Pump |
Measuring inputs Rack position
M
i t ti
Measuring input 2 HTEn pesten Read » Start
| Dosing device 1 (05 n u
Stirrers Lift position
L stirrer 1 (804)
7-Sample changers E Ready » Start
NEa
Stirrers Robotic arm position
L
Stiner 1 {Tower) Current posiion ’
- Measuring devices Ready } Start
Terget poston . <[> |
Pump 1 Pump 2
[l v
Close

In the left-hand part of the window the control devices
connected are listed together with their peripheral devices.
In the right-hand part of the window the functions of the
device selected are displayed, in this example those of the
tower of an 815 Robotic USB Sample Processor XL.

3 Select a tower

= In the left-hand window, select the tower of the Sam-

ple Processor used.
= Click on the tab Move.
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4 Move to a lift position

n NOTE

After initialization, the Sample Processor is not at a valid
rack position. This is displayed with "-----" under Cur-
rent position.

= Under Rack position, click on the [Start] key or [*].
Sample 1 is moved to.

= Under Lift position, move the life with the keys [4]
and [v].

= Set the lift height to be used as work position, i.e. the
electrode is immersed.

5 Assign a work position

= Click on the tab Assign position.
Under Lift position, the current lift height is entered.
The option Work position for = Tower is preselec-
ted.

General Move Assign position [ Pump

Rack position
Current position I:I Special beaker ‘ IE‘ || Assign "
Lift position
Current position mm ®) Work position For
O Rinse position for
(O shift position for
() special position Far

(] Swing position ‘Extarnal positions BH Assign [%_]

Robotic arm position

Current position ® External position

IE‘ | Assign I

= Click on [Assign].
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6 Assign a shift position

= Click on the tab Move.

= With the key [a] move the lift up so far that the rack
can freely rotate without damaging the electrode or
sample vessels.

= Again, click on the tab Assign position.

= Under Lift position, select the option Shift position
for = Tower and click on [Assign].

7 Assign a rinse position

= Define the rinse position in the same way, but with the
option Rinse position for = Tower.

8 Test the settings
= Click on the tab Move.

General ‘ Move [ Assign position ] Pump |

Rack position

wentpostion [t ]
art
) Ready -
Target postion ElCE
Lift position
Start
T Ready -
Target position D“E‘ i n n
Robotic arm position el
Shift position
Current position Rinse position| * I } Start
Special position Ready
Target position -
Home position n n

= Under Lift position, select the option Target posi-
tion = Work position and press [Start].
The lift now moves to the height that has just been
defined.

= Check the shift and rinse position in the same way.
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Defining special beakers

Special beakers are particular rack positions which can be used,
for example, as rinsing or conditioning beakers. Special beakers
are preferably set at high rack positions so that sample series can
start from rack position 1. Lift positions must be separately
assigned for special beakers.

Proceed as follows:

1 Move to a rack position
= Click on the tab Move.
= Under Rack position, enter the required position and
click on [Start].

The rack position is moved to.

2 Assign a rack position

= Click on the tab Assign position.
Under Rack position, the current position is entered.
The option Special beaker = 1 for the first special
beaker is preselected.

General Move Assign position [Pump |

Rack position

Current position Special beaker ‘ IEH Assign %J
Lift position

Current position 20 | rorm ®) [work position For

) Rinse pasition Far

(O shift position For

O special position For

@ Swing position | Assign
Robotic arm position
Current position 578 External position IE‘ | Assign I

= Click on [Assign].
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3 Test the settings
= Click on the tab Move.
= Under Rack position, click on the key [*].
The next sample position is moved to.

General ‘ Move [ Assign position | Pump |

Rack position

curentpostn L] Ready MIEED

Target position 142 E n u
. o Special beaker 1+
Lift it
1t position % Special beaker 2
Current position Sperial beaker 3 mm I ’ St
art
- Special beaker 4 Ready =
Target position i
Special beaker 5 n n
Robotic arm position Special beaker &
Current position Special beaker 7 ° I
" Special beaker 8~ Ready » Start
Target position oo = n n

= Under Rack position, select the option Target posi-
tion = Special beaker 1 and click on [Start].

The rack position that has just been defined will be moved
to.

4 Move to a lift position
= Under Lift position, move the life with the keys [4]
and [¥].
= Set the lift height to be used as work position, i.e. the
electrode is immersed.

5 Assign a work position

= Click on the tab Assign position.
Under Lift position, the current lift height is entered.
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General Move Assign position [ Pumnp

Rack position

Current position Spercial beaker ‘ IEH Assign
Lift position
Current position rrn ® work position For Tower F

Tower e
Special beaker 1
(O shift position For Special beaker 2
Special beaker 3
O special position for Special beaker 4

. Special beaker 5 . .|
O Swing position Assign
el Special beaker & | L
Robotic arm position Special beaker 7

-
Current position ® External position ‘ IEH Assign I

) Rinse pasition Far

= Under Lift position, select the option Work position
for = Special beaker 1 and click on [Assign].

6 Test the settings
= (Click on the tab Move.
= Under Lift position, click on the key [4] or [¥].
The lift is moved.
= Under Lift position, select the option Target posi-
tion = Work position and press [Start].

The lift now moves to the height that has just been
defined.

7 Close the manual control
= (Click on [Close].
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3.2 Creating an automation method

The method created in part 1 is now to be extended to an auto-
mation method so that a sample series with 3 samples can be
automatically processed.

n NOTE

It is assumed that a Sample Processor with one tower is used
for creating the automation method.

3.2.1 Loading the method

Proceed as follows:

1] ] 1 Open the program part "Method"
% = In the sidebar, click on the symbol [Method].
The method editor is displayed.
T ———r

2 Open the method

)
= Click on the symbol & or the menu item
File » Open....
= Select the method Tutorial and confirm with [Open].

The method is loaded.

Meaning of the individual commands

The following commands are required for a simple automation
method:

o With the command MOVE a rack position or an external posi-
tion (with Swing Head only) is moved to.

Move
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LIFT

Lift

With the command LIFT the lift is moved to the required height.

STIR

Stir

With the command STIR a stirrer connected to the Sample Pro-
cessor is switched on or off.

PUMP

Pump

With the command PUMP an internal or external pump on the
Sample Processor is switched on or off.

3.2.2

& [ Titration

@ Measure

@~ ) Calibration

¢ ) Doding

- ) Autamation
Q

) SWING

Extending the titration method

Moving to the first sample

In front of the titration command DET pH, insert a command to
move to the first sample. Proceed as follows:

1 Insert the command MOVE

= Select the command DET pH.
The command is shown in a black frame.

= Click on the symbol ® or the menu item
Insert » New command....
= Double-click the item Automation.
= Select the command MOVE and confirm with [OK].

The command is inserted in front of the titration command
DET pH.

MOVE

Move

2 Open the properties dialog
= Double-click the command MOVE.

The properties dialog of the command is opened:
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HAMOVE - Move x|

Device

Device name | ot defined [~]
Device type | 814 USE Sample Processor B

Target

Tower L[]

Mawve | Sample position [~]

Beaker test
® Display message
O Stop determination

O Stop determination and series

Parameters

st rate “4s
Shit direction
Suing rate I

[ Ok l ‘ Cancel

3 Carry out settings

= Under Device name, select the Sample Processor con-
nected.

The other parameters are already set correctly and do
not need to be modified.

Confirm the entry with [OK].

Moving the lift to the work position

After the command MOVE, insert a command to move the lift
to the work position. Proceed as follows:

1 Insert the command LIFT

= Select the command DET pH.
The command is shown in a black frame.

Click on the symbol B or the menu item
Insert » New command....
Double-click the item Automation.
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= Select the command LIFT and confirm with [OK].

The command is inserted in front of the titration command

DET pH.
LIFT 2 Open the properties dialog
Lift = Double-click the command LIFT.

The properties dialog of the command is opened:

ESLiFT - Lift x|

Device

Device name | not defined =]
Device type | 814 USE Sample Processor B

Target

Tower [1 [
Lift position Waork. DDSItIOnE mm

Parameters

Lit rats minls
[ oK

] | Cancel

3 Carry out settings

= Under Device name, select the Sample Processor con-
nected.
The other parameters are already set correctly and do
not need to be modified.

= Confirm the entry with [OK].

Switch on the stirrer

After the command LIFT, insert a command to switch on the
stirrer. Proceed as follows:

1 Insert the command STIR

= In the same way, after the command LIFT, insert the
command STIR.
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STIR 2 Open the properties dialog
st = Double-click the command STIR.

The properties dialog of the command is opened:

E¥sTIR - Stir x|
Command name | Sk

Device

Device name | nat defined
Device type | 814 USE Sample Processor

Stirrer

Stirrer

Stirrer type  |unknown

& &

Stirring rate

Action

@ switch on

O Switch off

O Duration | 1o ][min =]

3 Carry out settings

= Under Device name, select the Sample Processor con-
nected.
The other parameters are already set correctly and do
not need to be modified.

= Confirm the entry with [OK].

4 Edit the titration command

E NOTE

As the stirrer is controlled by the command STIR, it must
be switched off in the titration command DET pH.

= Double-click the command DET pH.
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= On the General/Hardware tab under Stirrer, select
the option Stirrer = off.
= Confirm the entry with [OK].

Switching off the stirrer

After the command DATABASE, insert a command to switch
off the stirrer after the titration finished. Proceed as follows:

1 Insert the command STIR

= After the command DATABASE, insert the command
STIR.

STIR 2 Open the properties dialog

stir = Double-click the command STIR.

The properties dialog of the command is opened:

R sTIR - stir x|

Device

Device name | not defined [~]
Device type | 814 USE Sample Processor E‘

Stirrer
Stirrer |1

Stirrer bype [ unknown

Skirring rate
Action
@ Switch on
O switch off

O Duration

OK ] | Cancel

3 Carry out settings

= Under Device name, select the Sample Processor con-
nected.
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= Under Action, select the option Switch off.
= Confirm the entries with [OK].

Rinsing

In the following steps you will insert the commands in order to
rinse the electrode, dosing tip and stirrer in special beaker 1. Pro-
ceed as follows:

MOVE 1 Insert the command MOVE

Move = After the command STIR, insert the command MOVE.
= Double-click the command MOVE.

The properties dialog of the command is opened.

2 Carry out settings

= Under Device name, select the Sample Processor con-
nected.

= Under Target, select the option Move = Special
beaker. The option Number = 1 is preselected for the
first special beaker.

= Confirm the entries with [OK].

LIFT 3 Insert the command LIFT

S = After the command MOVE, insert the command LIFT.
= Double-click the command LIFT.

The properties dialog of the command is opened.

4 Carry out settings

= Under Device name, select the Sample Processor con-
nected.

= Under Target, select the option Lift position = Rinse
position.

= Confirm the entries with [OK].



PUMP

Pump

5 Insert the command PUMP

3 Titration with automation

= After the command LIFT, insert the command PUMP.
= Double-click the command PUMP.

The properties dialog of the command is opened:

= ruMP - Pump
Command name | Pump

Device

Device name | not defined
Device type | 814 USE Sample Processor

Pumps

Tower

Pumpis)
Action
@ Switch on
O switch off

O Duration

l

Ok ] | Cancel

6 Carry out settings

= Under Device name, select the Sample Processor con-

nected.

= Under Pump, select the option Pump(s) = 1+2. With
built-in pumps, pump 1 is used for rinsing the titration
head and pump 2 is used for aspirating the solution so
that the special beaker does not overflow.

= Under Action, select the option Duration = 3 s.

= Confirm the entries with [OK].

7 Edit method properties

= Double-click the command START.

The properties dialog of the command is opened:
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General [ Application note

x

Command name

1 Method watiables ]

Workplace view

@ Current view

O view [ =]
Track view for live window
Live display 1 | Main brack [~]
Live display 2 | Main brack [~]

[ statistics
Nurnber of single: determinations | not defined [~ ]|

Conditioning

¥ Automatic conditioning

O l { Cancel

Switch on statistics

= Switch on the option Statistics.

= Enter the number of determinations to be carried out,
in this example 3.

= Confirm the entries with [OK].

The method is now ready and can be checked with a method
check and be saved afterwards.

Method check

Proceed as follows:

Start the method check

= (Click on the symbol ' or the menu item
File » Method check.

If the method check has been completed successfully, the
following message is displayed:
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013-118 Method test ok |
6 The method test has been successFully Finished.

2  Finish the method check
= Confirm the message with [OK].

Saving the method

Proceed as follows:

1 Open the method table

= Click on the menu item File » Save as....

The method table is opened.

2 Enter a method name

= As method name, enter Tutorial Automation and
confirm with [Save].

The method is saved.
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3.3 Performing a sample series

3.3.1 Creating a sample table

You will now create a sample table in order to carry out a series
of three determinations fully automatically. In a second step you
will configure the sample table the way the sample size is directly
transferred from the balance to the sample table. Proceed as fol-
lows:

1 Open the program part "Workplace"
CD‘ = In the sidebar, click on the symbol [Workplace]

2 Open the sample table

= In the subwindow Run, click on the tab Determina-
tion series.

Single determination Determination series |

P Start | Stop | Hold | | Pause ‘ staws |
Determination parameters

User |ih | Sample number El

Remark | Bl

Autostart |E| of Sample table E‘ [ staistics |El of |Zl

Sample data
BEN BT D

‘ Method ‘ Sample position | D1 ‘ Dz | 103 | Sample size | Sample size unit ‘
>

[<] [

l Edit ¥ ] I Sample table ™ ] Loaded |

3 Open the entry dialog
= Under Sample data, double-click the highlighted line.
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The entry dialog for the individual samples is opened:

5,
=11

Method

Sample position 1 |

D1

Dz

03

Sample size 1.0 Sample size unit |g
Line |B|E| EI ‘D‘E\E| af 1 | Apply ] [ Close ]

[ pisplay application note

KN E1(R1{X

4 Enter the sample data for the first sample

= Under Method, select the previously created method
Tutorial Automation.

= Under ID1, enter a sample identification for the first
sample, e.g. Sample 1.

= Click on the symbol E].

The data is entered in the first line of the sample table. A
second line is automatically added to the table. The
method and the sample identification are copied. The sam-
ple position is increased automatically.

5 Enter the sample data for the samples 2 + 3

= Modify the sample identification for the second sample,
e.g. Sample 2.

= Click on the symbol E].
The data is entered in the second line of the sample
table.

= In the same way, modify the sample identification for
the third sample.

= Confirm this last entry with [Applyl.

6 Close the entry dialog
= Click on [Closel].
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3.3 Performing a sample series

In the next step you will configure the sample table the way the
sample size is automatically transferred to the sample table.

Configuring the sample table

Proceed as follows:

| sagls e 1 Open the properties dialog
Mew
Load... = In the subwindow Run, click on the menu item Sam-
o o ple table » Properties....

@ Sample table test...
FEF prink (PDF)...

Properties...

Import data...

Properties - Determination series

N\ peset Display | Edit [ Process I Data impart

The properties dialog of the determination series is opened:

x|

1 Comment |
[] Accept data with |Samp\e size |z\|
[ Lok editing in warking sample table
Copy automatically into next line
W] Method W 101 [Capivvd W3 o4
[ 5ample size Ows Cie Ow? Cs
[¥] sample size unit [ 1o 11 iz
[ sample position + 1 [ 1013 [ 1pi4 Oipis Oipie
Ok ] | Cancel

2 Define the data entry
= Click on the tab Edit.
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I Sample table ™

New
Load...

E Save

Save as...

% Sample table test...

FLF print (PDFY. .
Propetties. ..
Impart data...

o'\ Resst

3 Titration with automation

= Switch on the option Accept data with. Sample size
is preselected.
If this parameter is switched on then a switch will be
made to the next line as soon as the sample size has
been transferred from the balance to the selected sam-
ple line.

= Click on the tab Data import.
=

Display Edit | Process Data import [cDmmEm }

[Jimport from balance

Balance | Sartorius_t =1

©) Aways accept data
O Accept data only for active window
[ confirmation necessary to accept data during detarmination
[J 1mport from barcode reader
Barcode reader | [-]
@ ahways accept data
O Accept data anly for active window
[ Confirmation necessary to accept data during determination
[ tmport from file
wpertfls [ ][]

Tmport Format ‘ﬁl

= Switch on the option Import from balance.
= Select the balance connected.
= Confirm the entries with [OK].

3 Save the sample table

= In the subwindow Run, click on the symbol E orthe
menu item Sample table » Save as....
= As name, enter Tutorial and click on [Save].

The sample table is saved.
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3.3 Performing a sample series

3.3.2
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Performing a sample series
Proceed as follows:

1 Prepare the sample

Select the first line of the sample table.
Weigh in the sample in a sample vessel.
Add solvent.

Press the [Print] key on the balance.

The sample size is inserted in the first line. The line for sam-
ple 2 is highlighted:

Single determination Determination seties |

P Start | Stop | Hold | | Pause ‘ Status
Determination parameters
User |ib | Sample number a
Remark | IE‘
Aukostart | 0 | of Sample table E‘ ¥ Statistics | 1] | of 3

Sample data

HEN BRE D

Method ‘ Sample position | D1 ‘ D2 | hinx] | Sample size | Sample size unit
1 |Tutorial ... 1 Sam... 48694 g =
? Tutorial ... 2 Sanm... g
_3 Tutorial ... |3 Sam... q
® ~
| ] [»
I Edit ¥ ] I Sample table ™ ] Loaded |

2 Prepare the sample 2 and 3

In the same way, prepare the second and third sample.

3 Place the samples on the rack

Place the samples at positions 1 to 3 on the rack.



3 Titration with automation

n NOTE

Under Determination parameters, the option Autos-
tart = Sample table is selected by default. This means
that the whole sample table will be processed. If you
wish to only partly process the sample table, then simply
enter the corresponding number of samples here.

'»Start 4 start the titration

= Click on [Start].
The titration is started.

In the sample table the current sample is highlighted in
orange, samples that have already been processed are
shown with a gray background:

Single determination Determination series
sl W Stop | Hold Pause Status

Determination parameters

User ‘]b | Sample number
Remark. ‘ E“
Autostart of Sample tahleB [¢7] Statistics of
Sample data
HEN BpX 2
Method Sample position | D1 D2 D3 Sample size Sample size unit
1 |Tukorial Autom... 1 Sample 1 4.8694 ]
| 2 [rutonial autem... 2 Sample 2 5.1236 a
73 Tuborial Autom,.. 3 Sample 3 4,3469 "]
»
[] ¥
[ Edit * l [ Sample kable ™ l Loaded |Tutorla\ (modified)
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3.3 Performing a sample series

Now the titration runs automatically. The following buttons
allow manual intervention:

| B Stop

Cancel the entire determination series.

n Hold

Pause the running determination.

i @B

Pause the series after the running determination.

333 Displaying statistics results

Proceed as follows to display the statistics results of a sample
series:

1 Open the program part "Database”

= In the sidebar, click on the symbol [Database].

2 Open the database

= Click on the symbol @ or the menu item
File » Open....

= Select the standard database tiamo and confirm with
[Open].



3 Titration with automation

ama =loix|

N
Fie Edt View Determinations Tooks Help

FO A 8 & Sl ) ARYTHRLYDE EE2AB HeES @@ 0
@@ Fiter [ all inati [7]] statisties [an =]
%. Determination start V| Method name I 101 Value I RSOL Name [ RS01.¥alue I RS01.Lnit
workplace || P L |2008-12-23 16:25:43 UTC+1  Tutorial Automation Sample 3 Res01 0.21 %o
2 |2008-12-23 16:23:43 UTC+1  Tutarial Automation Sample 2 Res0l 0.19 %
w 3 |2008-12-23 16:21:35 UTC+1  Tutorial Automation Sample 1 Res0l 0.21 %
Database
Method
& B | IR 1303 vl 4] ] ;
DET pH.1 Determination comment Results overview
Configuration C | Messages

Determination 1D -15547F77:11eé:
Server name: 127.0.0.1

cliert name; jb-2

w

Sample: number:

Start counter:

@

Recording
Determination start: 2008-12-23 16:2
Determination duration: 103 5

Determination run:  regular with rem:

o

DET pH E : . - =
’ z Method e Command "Calculations’
3

Res0li 0.21%
0
H e
5
6
4
1

H User (shart name): ib
v mi] 1 e | dzl
Marwal
Press F1 for help | I |E‘| [

3 Open the properties window

= Right-click the subwindow Results.
The context menu is displayed.
= Click on the menu item Properties Results.

The properties dialog for the result view is displayed.

Properties result window x|

Display for results overview

[l Statistics

Display for calculation commands
V] Results
¥ statistics
W] assignment
¥l Formula
[ variables
[ Ok ] l Cancel




3.4 Extending the automation method

4 Show the statistics data
= Switch on the option Statistics.
= Confirm the entry with [OK].

In the subwindow Results, the statistics data for the sam-
ple series is displayed:

T EE—— —————.O
Results overview [W]Wl
Command ‘Calculations’
Res01: 0.21 % Mean value: 0,20 %
s{abs): 0.012 %
s{rel); 5.68 %
Minimurn: 0,19 %
Maximum: 0,21 %
n 3of3

3.4 Extending the automation method

A samples series is processed in the following three phases:

1. Start sequence: Commands that are carried out once at
the start of a sample series.

2. Sample sequence: Commands that are carried out for
each sample.

3. End sequence: Commands that are carried out once at the
end of a sample series.
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3 Titration with automation

In tiamo™, these single sequences can be subdivided into part
sequences, the so-called tracks. Each track contains a START
and an END command which cannot be deleted. Any commands
can be inserted between them.

In the following steps the automation method that has just been
created will be correspondingly modified.

E NOTE

The method will be programmed the way the electrode will
be stored in a beaker filled with conditioning solution at the
end of the sample series. A second special beaker has to
defined for this purpose (see Chapter 3.1.4, page 49).

Creating a series start track

Create a series start track and insert a command resetting the
Sample Processor to normal status at the start of the sample
series. Proceed as follows:

1 Open the program part "Method"
= In the sidebar, click on the symbol [Method].

The method editor is shown.

2 Open the method

= Click on the symbol @ or the menu item
File » Open....

= Select the method Tutorial Automation and confirm
with [Open].

The method is loaded.
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3.4 Extending the automation method

j 3 Create a series start track
\_J Series end track
jgﬁ;‘ﬁgtk = Click on the symbol & or the menu item
Insert » New track....
= Select the item Series start track and confirm with
[OK].
A new, empty track will be inserted beside the previous
track.
RACK 4 Initialize the Sample Processor

Initialize rack

= (Click on the symbol ® or the menu item
Insert » New command....
= Double-click the item Automation.
= Select the command RACK and confirm with [OK].
= Double-click the command RACK.
The properties dialog of the command is opened:
X
S —

Device

Device name | nat defined =]
Device type | 814 USE Sample Processor B

[] Rack test

I OK ] ‘ Cancel J

= Under Device name, select the Sample Processor con-
nected.
= Confirm the entry with [OK].

Creating a series end track

Create a series end track and insert commands to store the elec-
trode in special beaker 2 (filled with conditioning solution). Pro-
ceed as follows:



MOVE

Move

LIFT

Lift

3 Titration with automation

H NOTE

Make sure a rack position is defined as special beaker 2.

1 Create a series end track

Click on the symbol & or the menu item

Insert » New track....

Select the item Series end track and confirm with
[OK].

A new, empty track will be inserted beside the previous
track.

2 Move to the special beaker

Insert the command MOVE.

Double-click the command MOVE.

The properties dialog of the command is opened.
Under Device name, select the Sample Processor con-
nected.

Under Target, select the option Move = Special
beaker.

Under Number, enter 2 for the second special beaker.
Confirm the entries with [OK].

3 Move to the work position

After the command MOVE, insert the command LIFT.
Double-click the command LIFT.

The properties dialog of the command is opened.
Under Device name, select the Sample Processor con-
nected.

The other parameters are already set correctly and do
not need to be modified.

Confirm the entry with [OK].
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3.4 Extending the automation method

4 Method check
= Check the method modified with a method check.

5 Save the method

= Save the method under the name Tutorial Automa-
tion extended.

Adapting the sample table

Finally assign this new method to the individual samples of the
previously created sample table (see Chapter 3.3.1, page 62).
Proceed as follows:

1] ] 1 Open the program part “Workplace"

@ = In the sidebar, click on the symbol [Workplace].

o\

| sampletatle ~ | 2 Load the sample table
Mew
load... 1. = In the subwindow Run, click on the menu item Sam-
&)
s ple table » Load....
Save as...
B Sample table test... = Select the sample table Tutorial and confirm with
FEF Brint (POF). .. [Load]_
Properties...
r\lmwﬂdatam The sample table is loaded.
» *Reset

3 Assign the method

= Under Sample data, double-click the first line.
The entry dialog is opened.

= Under Method, select the previously created method
Tutorial Automation extended.

= Click on the symbol ).



3 Titration with automation

= In the same way, modify the method for the second
and third sample.

= Confirm this last entry with [Apply].

= (lick on [Close].

4 Save the sample table

Save the sample table under the name Tutorial
extended.

A sample series can now be carried out with the extended
automation method and the correspondingly modified
sample table (see Chapter 3.3.2, page 66).
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